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Zedmed v36.5.3

Upgrading to this version will provide the following update.

Resolved error "Is not a valid integer value" when trying to distribute letters from batch writer

Clinical | ZED-9106 This error occurred for patients who had a referral that was created in Office > Patient Details

Zedmed v36.5.2

Upgrading to this version will provide the following features and updates.

To assist with the adoption of these new features, see the Zedmed v36.5.2 checklist.
We now have a webinar that demonstrates the new features on our home page!

NEW Electronic signatures
Electronic signatures can now be added to letters and referrals by applying the 'signature image' merge field. Simply save the
practitioner's signature as an image file and upload it to their profile. Learn more.

NEW Secure Send
Secure Send is a feature that uses email or ZedSMS to send invoices, documents and referrals (including radiology and pathology
referrals) to the patient or payer using a link to a secure download. Learn more. To enable Secure Send, submit arequest form.

NEW Automatic recall reminders
SMS recall reminders can now be scheduled to go out automatically using the same process as scheduled appointment reminders in
Zedmed's SMS Configuration console. Learn more.

NEW MyMedicare support

MyMedicare is a voluntary patient incentive scheme designed to formalise the relationship between patients and their practitioners.
This update adds support for the MyMedicare bulk billing incentive items, and the ability to record and display a patient's
MyMedicare registration status in Zedmed. Learn more.

Resolved Error: Cannot Reconcile Patient - Duplicate Message_ID
Office ZED-8766 | Fixed an error that could occur when performing a provisional patient merge. This error would occur when the
patient already exists in Zedmed and replies to an SMS before the patient reconciliation occured.

Resolved an Error that appeared when adding a patient to an appointment from the waiting list.
Office ZED-8767 Fix an error that occurred when adding a patient to an appointment using the cancellation waiting list - if an
SMS reminder had already been sent for the existing appointment.

Resolved Error Code 400 when creating a Doctors App QR Code.
Office ZED-7765 | Fixed an error that could occur when creating a Doctors App QR code in Zedmed. The code is scanned by a
user to enable to app on their device.
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Office

ZED-8794

New Medicare Plus Incentive items
A notification will advise if New Medicare Plus Incentive scheme items are available to the patient during
billing. This includes the new MyMedicare incentives.

The following billed items qualify for Medicare Plus Incentive items.
Click "Add Items’ to automatically add the ticked items to this invoice.

Incentive
ftems

o 10990(25/10/2023) 3

Items Description

for service item of Group A1 of Category 1

Office

ZED-9076

Access violation on Secure Send
Fixed an access violation that could occur if that patient has no account payer

Office &
Clinical

Removed the Zedmed Clinical service and Zedmed HI Service.
Zedmed's software no longer uses these 2 services. Their functions have been incorporated into the Zedmed
API.

Clinical

ZED-8978

Fixed the Results Inbox sort order
The Results Inbox now sorts the results correctly when sorting by the Result Reported Date when you use Get
all Results for a Patient button. The Result Reported Date is the date of collection/testing

Clinical

ZED-8589

New Radiology referral template: iMed Radiology Imaging Specialist
The Radiology-MedReferralSpecialist request form is now available as a Radiology Form in Clinical.

Clinical

ZED-8881

New Radiology report template: iMED Radiology - Myocardial perfusion imaging request
The report template Radiologyl-MedMyocardialPerfusionlmaging is now available in Clinical.

Clinical

ZED-8702

Thered lines in Zedmed's modern Ul option can be changed to grey
Added the ability to change the red lines separating each section in the Clinical Ul to grey lines. This is changed
in Clinical Tools > My Options > General tab under Line Colour: Red/Grey.

Show | Last 10 Consultations
Default Template
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Clinical

ZED-8728

Removed Measurements from the Clinical document writer's Details Merge fields
Removed the outdated "Measurements" merge field from the Clinical document writer's template tools. The
"Measures" merge field should be used going forward.
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AIR Update - New mandatory field: Vaccine Type (Regulatory compliance update)

Added a new field mandatory field called Vaccine Type that will be required for government compliance in
March 2024, and expanded the Route option descriptions.

Immunisation
Doctor

Branch: Albany Road Clinic b [J Mot Given Here

Name:  Phillip Davis Administered Overseas
Immunisation Details

Brand/Vaccine: l

| | Manual..
|:| Incdude non-AlR vaccinations

Date Given: | 104012024 =
Dose: School ID: Required only if immunisation

Clinical |ZED-8802

administered at a school
Batch Number: ~| [ store Batch No. (awailable from the ACARA
Australian Schools Lisf)
site: | -
Route: [ ]intramuscular [ Subcutaneous [ 0ral  [Jintradermal

[ Vaccine Type: [] Antenatal CINIP or Commonwealth [ |Private || State Program ]

Comment: | |

Add Recall o oK X cancel
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Clinical |ZED-8781

Send directly to pharmacy option for electronic prescriptions (Regulatory compliance update)

On the Electronic Prescriptions screen, there is now a "Send directly to Pharmacy" checkbox with a reasons
drop-down. This option will print out a QR code (token) for the prescription that can be faxed or scanned then
emailed directly to the pharmacy. This is for compliance with state and territory legislation that prevents
prescriptions from being given to patients for specific controlled substances.

Hiectronic Prescrigtion

Or Fhalip Dz RACGE | Metes tor pharmacist staged supply, speaal approval, spectic condition, ete).
Braneh 1 HOTE: may be visible be natient,

Lewel 3, &0 Albert Road
S0UTH MELBOURNE 3205

Presuriber Number. 3577773 Phane Humber: 03 9264 3300

FANENE'S HAmE MS MATENAA-L OIS 10nes: Fatienrs Mesicare 22980398741

Address & Janes PI Haae

GOWRIL 2904 Fhamacrutical benetits antalemert Route of Adminstration Oral

rumber

Date of Birth  19/05/1967 FESSatyMet  []  Concessionsl of sepancant O | clinical Ingication -
erditlement card RFES beneticiary or PUS Satety

Date 03/01/2024 holder Met card holder

Minimism Rapeat intersal [y |

PES [X  @PEs [ Brand substitutions not permitted ]
Warmant aumber

Rosuvastatin Smg Coated Tablet Smg [30]
PUFF

avy: 1730 5 repeats

[l uwnusual Dase

[ Senipt 15 tor urgent suppiy [seript awing)

Blectronit Prescribang Token delivery

Osms [p06e31 730

CEmail |

(oo Electronic Token
(I Print Paper Token

B Unloac soript to Active Script List

o

[ )5eng presenption cirect to Pharmacy  Heason Dosing Palnt

The option sbove will prevent the patient from receiving the token. It is intended that the paper Loken
|3 printed and proviced directiy ta the pharmary.

This i due Lo & requirement in indwidual state and lerritory legisistion thal prevents prescriptions from
neing handed aver to the patient for specdic controlled substanees,

v

[E Fresuibe Blechonically | Cancel
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Dosage information is now mandatory for all prescriptions (Regulatory compliance update)
Prescribing now requires dosage information in the Dosage Full Text field. This is a compliance update for

electronic prescribing that has been applied to all scripts.

¥4 Script Details
Atenolol 50mg Coated Tabiet 50mg [30]
You selected: Atenolol S0mg Coated Tablet [Tablets) S0mg [30] |,
Dosage Frequency i MIMS i
capsule | after meals b, The MIMS information displayed below is of product “Atenclol REX Tablets S0mg 307", this
Half a drop | 85 directed information may vary for other products/brands with the same generic name.
. | =i ITI,:I'R } :::\llz;:l!d MIMS Dosage
2times a day | before meals Admin > 100 mg/day as divided dose. Hypertension: initially 50 mg/day; may incr by 50 mg/day every
1 2times a day | inthe morning wi to max 200 mg/day. Angina: inttially 50 mg/day; may iner to 100 mg./day. Arrhythmia
a 5 6 Atimes a day maintenance: $0-100 mg/day. MI maintenance: 50 mg/day for 1-3 yrs. Initiate after early intervention
every 4 hours with other agents or immediately if patient presents > 12 hrs post-ML. Renal impairment, CICr 15-35
every 6 hours mb/min: 50 ma/day or 100 mg on altemate days; CICr < 15 mL/min: 50 mg on alternate days or 100
7 8 9 ongce a day my every 4th day; haemodialysis: 50 mg after dialysis. Elderty: consider dose reduction. Withdrawal:
| . weekly reduce graduaily over 8-14 days
Cir L] 00
Clinical |ZED-8840 - Biua Use
Error x all grades incl renal origin; frequent disabling angina
Caleuater arthythmia; M (late intervention) (> 12 hrs after thest pain
9 Dosage infr ch for use) must be o in arder
10 preserbe, N
g —
| | -
¥7 Undo C4 Redo | | Clear
(@) Regular Use (I PRN () Short Term
Quantity |1°30 ‘ Repeats _ PBS does not allow repeats
Seript Date:  [19/12/2023 | PBS Status
[ Hide from display farchive) i not current  Medicine estmated to last until [2501/200¢ ) ®riate Opes/mres Onres Cees Osedion 100
[ upload script to Active Script List [AWarn me to renew scriptafter [osoy/2024 | [Reges Indlude Brand on Script
[ autharity Brand Substitution NOT Permitted
Drug Notes
|Add to encounter notes
MIMS P, BIMS CAL _;ﬁ_Md anh mm History |E Preseribe ﬁeﬂmnmb‘l | J Prescribe x Gancel
New Practitioner ID option as an alternative identifier for Online Appointments.
Zedmed can generate a Practitioner ID so a doctor can be set up for Online Appointments. This is ideal for
treating doctors without an HPI-I. The Practitioner ID is assigned in the doctor Details screen, along with the
Available Online setting for OLA.
Clinical Settings
Qualification |M8BS Details New
Bt [ Status <
scriber No External Primary
Dl assist only DSurgnn Only
Email Address |
| ECUIPSE Fund Schemes [J show Code on Appt. Screen
Online Appointment System Text for specialty treatment
ZED-8650 . P 3
OLA Practitioner 10
ZED-8649 |tes201Fa0- |l ceneate
Signature Image
Find [
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Patients must now choose an appointment type in Online Appointments

Online Appointments no longer has a default appointment type. Patients must select an appointment type to
create a booking, ensuring they book for the intended appointment type. This prevents patients from booking
the incorrect appointment type and allows you to only give new patients a new patient appointment type.

OLA ZED-8654 3
What type of appointment are you
booking today?
[ 5td Consultation \ [ Review Consultation ‘
N
Zedmed v36.3.4
Upgrading to this version will provide the following updates.
o Resolved Error: Item not found when closing a patient file in Zedmed Clinical.
Clinical | ZED-8867 This error occured when opening a patient in Clinical from Office, if Clinical had not been shut closed properly.
o Resolved Error: List Index (1) out of bounds.
Clinical | ZED-8886 This error also occured when opening a patient in Clinical from Office, if Clinical had not been shut closed properly.
o Resolved Error: Unsatisfied constructor on type: MyHealthRecord.Conversion.TMhrDocumentView.
Clinical | ZED-8865 The error occurs when trying to view a result that has been added to the summary view from My Health Record.
Resolved Issue with Zedmed Upgrade file v36.3.3
Upgrader | ZED-8882 | The error prevented some users from upgrading.
Zedmed v36.3.3

NEW HealthShare integration

The Clinical Address Book is now integrated with HealthShare so practitioners have access to Australia's largest Specialist and Allied
Health directory when sending letters and referrals. This feature requires internet access. Learn more in our HealthShare guide.

NEW Intramail search

There is now a search option in Office and Clinical Intramail so you can search your inbox and sent items for mail using the sender's

name, subject, date range or a linked patient. Learn more in our Intramail guide.

NEW Editor for Office templates

For customers who do not have Microsoft Word, we have added a Zedmed RTF editor so you can create custom Office templates.
This is useful for on-premise customers moving to Zedmed Cloud. Learn more in our new Office templates guide.

Banking Report enhancements

10 updates to Zedmed's banking reports to improve clarity and consistency.

Office

ZED-8409

Support has been removed for 3rd party SMS providers
Support for "SMS Everyone", "Inspirus" and "Other"(generic) SMS providers has been removed. ZedSMS
replaces these providers for the sending of SMS messages from Zedmed.
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ZedSMS performance updated

Office ZED- 8832
I The ZedSMS SendPoint was updated to improve the send and receive speed of SMS messages.

ZedSMS Purchase Link updated
Office ZED-8466 |Updated link to purchase credits for ZedSMS due to the change in supported providers. It now points to the
ZedSMS Message Centre.

Banking Report enhancements
The following enhancements have been made to Zedmed's Banking reports:

e Removed unused HealthPoint sections from bank reconciliation, deposit & session reports.

e Widened the payer name column On behalf of to accommodate longer names.

e Renamed the 'Bank Reconciliation Report' heading from Reversals to Cross-Session Reversals to
reflect the data presented more accurately.

Baiches
Clossd On Bafch # Cash Cheques MC Chq Cards Total EFTPOS
23-Jun-2023 4 21350 0.00 270 10675 341335 4.212.43 14260
Totals 21330 000 270 10875 41335 4,212.43 142,60

HealthPoint

0.00

Totals 0.00
Direct Deposits
Date Paid by Bank Branch Details On behalf of Pay Date Amount
0iddunZ023  Medicare Reserve Canberra Dr Jackson Medicare 132.45

e Updated the Bank list label to say, Show Inactive Bank Accounts (previously 'Show All Bank').
¢ The New page on staff change checkbox is now only enabled if the Group by staff member checkbox is
ticked.

Office ZED-8418 Banking Reports

Use this screen to print reports on previous and current batches and sessions. If you want to close a batch or session, please use the
Bank Deposit screen or the Print/Close Session screen.

To ensure this report includes all transactions from all other workstations, it is recommended you exit from all
instances of Zedmed Office running on this workstation and log in again.

Style Criteria
(®) Batch Details Banklist [|:| Show Inactive Bankkccount]
Batch Mumber | <Current Batch=> v | Albert Road MC Bank Account v
() session Details [ Group by staff member
Session Mumber | 34 Started On 15/03/2023 9:22:1% AM v New page on staff change

O Reconciliation Report

From [o1/112023 & | To [30112023 2|

Print Screen Expart Help

Test Branch 1 PDAVIS

e Fixed anissue where payments by staff would not print on separate pages if the option 'New page on
staff changed' was selected.

o Fixed anissue to prevent using the same reason text for all reversals made without closing the
payment enquiry form.
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Resolved an issue with the inclusion of cross-session reversals

The Banking Batch Details Report now takes into consideration any cross-session reversal transactions in

the overall totals section of the report.

Services
Date ltem# Description
= | "

Save invoice(s) error!! Press 'Cancel' button on Invaice Form to
cancel the invoice!

Motes

Session Totals Overall Total 71.30
Cash 7130 Credit Card 000 Cheques 0.00
Direct Deposit 000 EFTPOS 000 Medicare Cheques 0.00
HealthPoint 000
Banking Session# 2
Banking Session# 6
rCrm;s-!’n;snion Reversals
Hi0TI2023 2 Black, Emma 71.30
. L W reng pay ment in difierent ses
Office | ZED-8445 || panont Totals Overall Total 71.30
Cash 71.30 Credit Card 0.00 Cheques 0.00
Direct Deposit 0.00 EFTPOS 0.00 Medicare Cheques 0.00
Changed the Banking Reconciliation Report date format
Office  |ZED-8463 ged 87 port
The Banking Reconciliation report now consistently uses "dd/mm/yyyy" as the date format.
Changed the date format for Reversals on banking reports
Office | ZED-8500 & -rorma : grep
Reversal transactions printed on banking reports now use "dd/mm/yyyy" as the date format.
Resolved an error encountered when canceling an invoice without a service record
This error occurred when creating an invoice, adding then removing a service and then trying to delete the
invoice. This error will no longer occur as the action buttons will be disabled when no service items are in the
service item list or in the add service item box.
Office  |ZED-8432 ()Fund (R
Error *
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Resolved performance issues caused by an Hl service outage

This fix prevents the Patient records from loading very slowly during the opening of multiple patient records
when the Hl service is down. The IHI check should now be run in the background for each individual patient
Office ZED-8436 | without slowing down the Ul performance.

Additional information has been added to the MHR Status section of the patient record and will display when
the IHI check is running and if the check times out it will update to display this information.

Resolved an issue that caused a Patient's name to be cut off on the Patient Letter pick list.

Office ZED-8480 . o . .
In the Patient Pick List Dialog - Last letter of Family name was cut off due to the font style.

Fixed Error 'Midnights not a valid time,' on the Waiting Times report.
Office ZED-8530 | Fixed anissue where an error was displayed when Midnight was selected as the End Time on the Waiting
Times report.

Resolved an issue that caused a patient's pronoun to disappear
Office ZED-8534 | Fixed an issue where clinic-defined pronouns (dropdown list management ) could disappear from the
pronouns selected for a patient.

Resolved Booking Wait Time Report issues
Office ZED-8594 | The Booking Wait Time report will now display changes from the last edit made to an appointment.
Additionally, the report has been fixed to prevent an error when running the report for a single patient.

Resolved an issue with the Date Details display in Linked Appointments
Office ZED-8596 | The Linked Appointment Details dialog has been updated to use text formatting consistent with the rest of
the application. This resolved Linked Appointment Details - Date Details overlap

Resolved issue that cut off the Patient Type details in the Appointment and Attendance Details dialogs
The Patient Type in Appointment Details and Attendance Details screens no longer overlap the screen.

Appointment Details

Office ZED-8598 || pate: Wednesday, 6 September 2023 Created by PD G lei i
" PO Simkins, Talia
Doctor  GRACE HERMAN on 06/08/23 3t 12108 g o a9 Pull File Yes DOB 24/10/1982
Resource Firstin 31/01/2023  lastin 15/08/2023 | Type Patient Type ABQ
Start Time Clinic | Branch 1 ~ | Contact Details
Al ; o Phone (H) 01000000 Work (W) 020000000
Moble 0410 654815

An Assist Fee can no longer be used with non Assist able item
Office ZED-8657 |When setting a billing item as an assisted item that is not an assistable item, the Assisting Billing Options
screen is no longer displayed.

Resolved anissue with the Service date and Billing date range in the Assistant Service Report.
Office ZED-8658 | Fixed the date picker button for “To date” on the Assistant Service Report so that the date selected is
displayed in the To field and not the From field.
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Office

ZED-8659

Fixed the layout of the reprint token message box.
Removed an incorrect line in the message displayed when reprinting an eScript token

Office

ZED-8772

Office will still run if the cancel button is clicked on the Login screen.
Fixed issue where Patients.exe would crash when Office was closed without logging in first (i.e. opens
Zedmed Office, then closes the login prompt to exit, without logging in).

Office

ZED-8777

Selecting F4 twice will once again bring up the last patient searched.
Fixed issue where if a patient is associated with more than one branch selecting F4 twice (or clicking on Last
button) did not open the last patient.

Office

ZED-7492

Staff Username truncates to 10 characters automatically
The "Edit Staff Member" dialog now prevents users from entering usernames greater than 10 characters in
length.

Clinical

ZED-8483

Added an Ethnicity field to Zedmed Clinical
Capturing or viewing a patient's ethnicity details has been added to the Family, Social & Past History
information in Clinical.

Clinical

ZED-8544

Resolved Ul Issues in Clinical Reports
Fixed some minor issues with font sizes and labels being cut off in the Clinical reports, including Font Types
or Font Size and Labels being cut off.

Clinical

ZED-8552

Updated the Intramail Ul in Clinical
Clinical intramail buttons and icons have been updated on main dialog to match those in Office.

Clinical

ZED-8561

Fixed the Results Inbox Error: Unexpected end of command-line 2, column 1
Results Inbox has been fixed to prevent an error when retrieving results for all doctors on clinics with a large
number of doctors configured.

Clinical

ZED8574

Enabled a configuration to limit attachments tab file size in clinical
Added a maximum value in MB's for uploading of files to tabs in the summary views and set the default. This
can be found in the Global Options > General tab.

Clinical

ZED-8595

Turned on Icon captions by default in Zedmed Clinical
Encounter icon captions are now turned on by default for users logging into Clinical for the first time.

Clinical

ZED-8630

Resolved a formatting Issue When Copying Clinical Notes to Letter Writer
Added a new Paste Plain Text option to the Letter Writer to allow formatted text such as encounter notes to
be copied and pasted into a letter without formatting.
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Clinical

ZED-8633

Introduced a Filter Feature for Merge Fields in Letter Writer
The Clinical Letter Writer now provides a filter function in the data toolbar, allowing for a quick look-up of a
field in the list of available merge fields.

Clinical

ZED-8687

Resolved an access violation in module 'crs_client.exe' when closing Patients in Clinical.
Fixed anissue where an AV error was displayed in some cases after closing a patient file in Clinical where My
Health Record is enabled.

Clinical

ZED-8778

The Write referral button in HealthShare will now only be an option in Referrals.
Removed the"Write Referral" button from HealthShare address book search when opening the search
screen from the main toolbar in Clinical.

Upgrader | ZED-8614

Removed obsolete Zedmed files and exe from the Installer/Upgrader
The Zedmed Upgrader has been enhanced to remove obsolete files from client installations.

Zedmed v36.1.1

Clinical

ZED-8668

PDF viewer unable to view the document - Blank Document
Fixed an issue that may prevent the viewing of older PDF files, especially those produced by scanning
documents

Zedmed v36.1.0

Zedmed 36.1.0 is a major release that introduces a modern theme, integration with accounting software including Xero and MYOB,
HealthLink SmartForm enhancements and pronoun and gender updates.

Shortcuts to specific sections:

Zedmed v36.5.3
Zedmed v36.5.2
Zedmed v36.1.1
Zedmed v36.1.0
New modern theme

Surgical Partners integration

Zedmed v36.1.0 Updates (part of the v36.0.0 release)
Zedmed v36.0.0 HealthLink SmartForms enhancements
Zedmed v36.0.0 Office & Clinical enhancements
Zedmed v36.0.0 Office & Clinical updates

New modern theme

No menus or layouts have changed, but you now have the option to use the new Modern theme or the existing Classic theme.
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File Encounter Results Reference Library Reports Tools Utilities Help

2 S X St

OpenPatient  Open Family  Close Patient Waiting room | Results inbox MIMS Address book Travel Batch letter To do list

Holloway, Andrea .

Holloway, Andrea Current Encounter - Duration: 00:00:41

&b & g A B

Problems Drugs Observations Referrals Immunisations umable Diagrams Templates

Address: 5 Kingsley Gr,

BENOWA 4217
: 26/12/1943 Home: @ Undefined Problem
: 79 years Work:
49503503111 Mobile: e RFE: | [ Use Coded RFEs [Management Plan
AS6 Occupation:

Summary Views

| Problems | Referrals | Resuits | Immunisations | Allergies | Images/ECG | Pregnancies |
Documents | Attachments | Measurements | | Incoming Documents |

History View

{7 Include MHR Sort: | Medication Text ;
o v i P Billing | 'dest Encounter: 20/05/2021
123/ v|&l & ity {228 wi

Prescribed >

Current Medications = izard| Visible:| Last 10 Consultations v Indlude MHR

Heguilarise Intramail
Paracetamal S00mg Goated Tablet 500mg [20] - TAKE 2 TID 12/08/2022 (Fri) 10:00am with Dr Phillip Davis at MED, for 4h 23m 10s
Paracetamol 500mg Coated Tablet 500mg [50] - TAKE 2 TID AS DIRECTED parental anxiety
PRN 15/07/2022 (Fri) 10:54am with Dr Phillip Davis at MED, for 16m 08s
Short Term Headaches
Non-current Medications 13/07/2022 (Wed) 11:21am with Dr Phillip Davis at MED, for 17m 45s

Stomach ache
20/05/2021 (Thu) 5:09pm with Dr Phillip Davis at MED, for 0m 20s
Allergy: Crunchy peanut butter

=
Reference View

Allergies: [crunchy peanut butter @
Warnings: PN
Recalls: | @

o The first time you open Office and Clinical after the upgrade, you will be prompted to choose a theme.
e You can have matching or different themes in Office and Clinical.
e You can swap themes at any time if you change your mind.

The first time opening Office - select Modern or Classic. To change -Themes > Modern or Classic.

2
Appointment Search View Refresh Waiting Room Patient Bill Encounters RefDrs Close Extra

Management Reports  Tools PracticeSetup WP Setup  Uilities |
Branch 1 ~|Hatcher, Danni = Reception Management

2T h 28 ) d) 29 ) h
7 lun (Tue) un (Wed) un (Thuj Patients (F4)
1 z“M 0| 0 0|
® Moder ‘ Waiting Room
Appointments
1A 0 9| 0

Day >

eek »  Month

Appointment Search View Refresh Waiting Roam Patient Bill Encounters RefDrs Close Extra Clinical Records.
5 & a . ary
> # - - - = J
i o e Branch 1 Hatcher, Danni ply |8
27 Jun (Tue) 28 Jun (Wed) 29 Jun (Thu)
A 0 of 0
O Classic ’
FAu 0 0 0 Message of the Day
Welcome to Serenity ~
Zedmed S/W Support
Tel: 1300 933 000
Fax 039284 3398
e T i After Hours: 0408 002 964
4 Month 4 Week 4 Day Day J} Week b Month b 3Months b & Months B 9 M v

Today
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Surgical Partners integration

Surgical Partners is a financial management platform that integrates Zedmed with accounting products including Xero and MYOB.
This allows you to use the financial information in Zedmed for a range of financial applications from debtors' management to banking
and payroll. This functionality is enabled by registering with Surgical Partners who will configure Zedmed to send the required
financial data to your accounting software each night.

To learn more, visit https://surgicalpartners.com.au.

Zedmed v36.1.0 Updates (part of the v36.0.0 release)

Implemented a new PDF tool to view results and scanned documents in Clinical
Clinical | ZED-8328 |Removed the requirement for Adobe Reader from Zedmed. PDFs can now be viewed (both when embedded
in aresult and when attached from a scan) without any external PDF viewer installed.
. Access Violation error resolved when deleting an Appointment Type
Office | ZED-8252 . . . .
Fixed an error that occurred when attempting to delete an appointment type from Office
Corrected the Message/Buttons displayed when a Tyro Easyclaim has been canceled.
Office | ZED-8360 | The message displayed when a user canceled a Tyro Easyclaim has been resolved and the form now allows
another attempt.
. Deleted prescriptions are no longer displayed on HealthLink Forms.
Office | ZED-8423 . . . L .
Deleted prescriptions were still showing up as selectable options in the HealthLink SmartForm.
The Encounter Timer no longer disappears when resuming an encounter.
Clinical |ZED-8452 | Fixed anissue where the Clinical Encounter timer would no longer be displayed after resuming an existing
encounter.
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Office

ZED-8481

Updated the Appointment and Full day icons for the Modern Theme.

Updated the icons displayed on the Appointment Grid for Appointment and Full Day menu bar options so

they are no longer similar to Zoom In and Zoom Out icons.

Zedmed v36.0.0 HealthLink SmartFormsenhancements

For new users, please follow the Zedmed SmartForms installation guide.

For existing users, please follow the manual upgrade guide.

Improved the names used for attachments in SmartForms
Each HL7 results file can include several sections, and Clinical Results Inbox displays them as follows:

1. Result View tab.

2. Enhanced View tab - HL7 file includes only 1 additional part.
3. Enhanced View #N - HL7 file includes N additional parts.

4. 2 and 3 are not always present, depends on HL7.

Results in HL7 files added as attachments to a SmartForm will be named as follows:

1. <HL7 FResult Name> (Result View) tab.
2. <HL7 FResult Name> (Enhanced View) tab - HL7 file includes only 1 additional part.
3. <HL7 FResult Name> (Enhanced View #N) - HL7 file includes N additional parts.

Clinical | ZED-8267 2 and 3 are not always present - depends on the HL7.
Requested Information Ak Diagnostic Reports / Patient Documents [ Browse for Pgtient Document || Browse for Local File
S Attach file from EMR supports: gif, himl, jpeg, doc, docx, pdf, txt, rif, tiff
Attach file from Computer supports files that end in types: doc, docx, gif, him, himl, jpeq, [pg. pdf, rif, tif, iff,
Caution: larger attachments may take significant time to preview
Attachments | Reports A [
Mo repors selected [O | Daln hiil— Gommants Raps fiza
MoTES sEached O | 1307/2023  Attachment et 1KB E
[Fo7 " 1210772023 Colorectal Cancer Structured | “hes | ®
Medications, Allergies, Pathology Report (Enhanced View
Alerts #1)
2 long lerm medicalions specified [ | 12/07/2023 | Colorectal Cancer Structured himl E}
ki et Pathology Report (Enhanced View
- #2)
- : : (] | 12i07/2023 Colorectal Cancer Structured pdi B
Medical, Social and Family Pathology Report (Result View)
ekt A 0 7 | 120072023 | Documents RTE fls ' T 0eE @
O | 1207/2023  ImagesECG ot 1KB ®
Zedmed's Healthlink SmartForms integration is now upgradeable
Clinical | ZED-8292 |The Healthlink SmartForms service installer has been updated from an MSI into an exe file (as used by other
parts of the Zedmed software) so the software is now upgradeable.
Healthlink SmartForm will display 1 attachment for HL7 files with 2 records
- The functionality of Zedmed's HealthLink SmartForms integration has been improved. HL7 results that
Clinical | ZED-8332

include PIT segments in addition to FT segments will be included as one attachment (as it is done in Clinical,

Results).
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Clinical |ZED-8379

The 'HealthLink Create Referral' button can be removed from the Encounter toolbar
Doctors can now remove the 'HealthLink Create Referral' button from the encounter toolbar. This is done in
Clinical > My Options > Function Selections tab > Show the HealthLink button.

[Current Encounter - Duration: 00:05:49

KoV SN[/ ARBDFFEH 2etE

General Drug Options Document Handling  Function Selections My Health Record F

My Options

E71Show the Problems button
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[ Show the Observations button
7] Show the Referrals button

2] Show the Immunisations button
4] Show the Allergies button

A Show the Consumable button
4] Show the Diagrams button

[ show the Templates button

E7] Show the Add Prablem button

[ Show the Delete Prablem button

[] Show the Pregnancy button

[ show the Chronic Disease Moduie button | & incude MHR

[ Show the Clinical Calculators button
[ show the Capture button
[ Show the Histories button
[~ Show the Spelicheck button
[ Show the Backdate button
[DShow the Create New HealthLink Referral button l

Clinical |ZED-8387

Resolved a scenario where a staff name could appear as the provider in a SmartForm

Resolved anissue that caused the provider details ( Referred By name) in a HealthLink SmartForm to be
populated with a staff member's details instead of the provider's details, when the staff member's ID was the
same as the doctor's code.

Zedmed v36.0.0 Office & Clinicalenhancements

Clinical |ZED-7979

New Pathology & Radiology referral templates added to the Clinical Addressbook for:

e Australian Clinical Labs Comprehensive Carrier Screen Request = PathologyClinicalLabsCCS
e Queensland Ultrasound for Women = RadiologyQUFW

e Sydney Ultrasound for Women = RadiologySydneyUltrasoundForWomen

e Vision Radiology = RadiologyVisionCardiac

Laboratory Details
|:| Use As Preferred Laboratory
LEL A T EadiologyMelbourneRadClinic

Lab Communications

DL Command Line l |

RadiologySydneyUltrasoundForWomen 2

RadiologyToowombaDiagnosticmaging DL Directory D'
RadiologyUniRad UL Directol =]
RadiologyUniRadiology o |
RadiologyUniRadiology2
RadiclogyVictorianMedicallmaging
BRI RadiologyVisionCardiac

Vertical Offset(mm)

P o ox X concel

Pronoun field added to Zedmed Office & Clinical
Added support for specifying preferred pronouns to Zedmed. Pronouns can be set in either the Office or
Clinical Patient Details forms and are displayed in the following locations.

e The selected pronouns will appear when chosen in the patient record Pronouns drop-down.
e Enabled at practice and branch level.
e Additional pronouns can be added in Practice Setup > Drop-down List Management> Pronouns.
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Office/
Clinical

ZED-1674

¥4 Drop-Down List Management [m] X

B Adive [J& [Imep [Jer3 []ers

Appointment Cancellation Reasons | Deseription
Chetklists PG
She/Her
Instrument:
They/Them
Procedure Type
Product Category
I Franouns
Prasthesis

Stock Movement Reason

Add Value Delete Value Close

Pronouns display:

e The header of patient details summary in Clinical.
e Title of patient details in Clinical.

Q ) ; (97]

Open Patient  Open Family Patier : MIMS

Jones, Mr Happy (They/Them) n

Jones, Mr Happy (They/Them)

e Patient record tab in Clinical.
e Title of patient details in Office.

#J Tones Hanny (They Them ]

AccEnquiry Aftend Bl Letters Clinical information  Print  Quote Receipt Waiting Room  Appointments  Extras

et ils I Persanal ; - : Practice )
’ ; - - Family Mame | Jones | Filew# |22
Further Details :
Recalls Givem Name |Happy | Initial Hosp. UR No |
Notepad Preferred Name | | T Fomer Usual Branch Branch 1 (22)
eHealth Title | M1 SewatBitth (M First In |
Messages Pronouns Fl'h_c;a; v Type

153

Pronouns & Sex at Birth
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¥4 Jones, Happy

*
Acc Enquiry Attend  Bill  Letters Clinical Information Print  Quote Receipt Waiting Room  Appointments  Extras
ujjghr'f De'EZGend r“P!tr(;; EGX"BI‘I!:BW" | e Fies[22 | Pull File ]
Office | ZED-8194 |[Fa@nged the "Gender" fietdro faml "Sex at Birth" in Offi¢etiClinjcal-ame e Patient Merge utilityical arnings
Notepad Preferred Name | | [ Fomer Usual Branch | Branch 1 (22) v
SBR &% creenshot above, T [ | ESE | fstn[ | st |
HIESHUES | Pronouns || 4] Type | [v] status [cument v
Date of Birth age[ 58 it
| |She/Her
Ethnicity is availabEItje rr‘:nrhe I;a Tent Mer geutitity “hons Hem €2 .
Office | ZED-8202 | Ethnicity is now available irréheetiemtler ge utility whepRmerking duplicate records. It is displayed when
Pdvanced is selected ™™ rumeg  8anch Defauit (ot set | s .
%, [Mobite || ] i

Fund Mo fund set for this patient

Do Not Send SMS [_| Default Appointment SMS [:] . e e
Usual Dr | None .

Changed the default dose for Prevenar 13C hildhood immunizatienras ;
Updated the dose from lf"fgcé"f?s?ﬁemﬁ}month Pﬁ'éumococcal (J|13vPCV) Childhood Scheduled Immunisation
Exp

i Add Detals
I 1 1
Childhood Immunisation Schedule »

Mational Immunisation Program Schedule - July 2020 |
Vaccine Brand/Naccine Date Batch Comment Dase Docdor Add...
> 12 Months A |

MMR 1 Modify... =
Clinical |ZED-8215 Adency: ! )
13vRCY 3 Deiete...
12 Months - in 5A a5 Dose 3 OR ATSI only as Dose 4
Tend 3
AT e e T0 URTCIETIL Calu, W0 Call QUUTE,
Delete | | Pint | | PatientVerification | Find Clgse || Cancel

Added the Service date to the Claims screen and Claims Report
Claims Status Ul and report now show the date of the service against each item in the invoice.

¥4 Claim Status

Refresh Default View Expand All Collapse All | Void Rejected Invoices
Claims  Payments

Office ZED-8326 ; :
From |11/07/2023 [E~ | @ ANl Submitted Claim Types | Branch <AlL> ~| Doctor | <All> ~ | Claim 1D

To 18/07/2023 [~ | O Mot Submitted Status <AlL> w|  Ppatient ANl Find Fatient Clear |
[ InvsService/Assessor) Date Inwv/Service | Status Patient Cutstanding Paid Doctor Claim 1D Medicare

= Inv 103015 18/07/2023 WITH ME...  Simkins, Talia 5331.50 50.00 Augustus Eason 211307 211307
=116 4/07/2023 Unpald 511050 50.00
16 11/07/2023 Unpaid 511050 50.00
116 18/07/2023 Unpaid 5110.50 50.00
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Replaced the PDF viewer for the "View Claim" button in Account Enquiry
Updated the application used to view PDFs in Office for Claims. Viewing a claim from the account enquiry
screen is now significantly faster.

¥4 Account Enquiry

Patient  Simkins, Talia

Payer Simkins, Talia ~ Recalculate
Curr 331.50 30+ 0.00 60+ 0.00 0.00
. Transaction
Office ZED-8370
Invoices Date Patient HIC _ CLm# Br__Dr Valuz __ Qutstanding
> I 103015 18/07/2023 SIMKINS, TALIA Pé PDF Viewer

™ saveAs (= print [Eh Print fwith printer selection) |+ BtWidth T FitPage /® ZoomIn = Zgom Out

Patient Claim Consent and Declaration

Location ID: SAP(2482 Reference: 211307

Zedmed v36.0.0 Office & Clinicalupdates

Important update.
Clinical ZED-8286 Reduced the flicker on the Results Inbox display list
Results Inbox module has been reworked to prevent flickering as users action results.

Resolved an error that occurred when merging patients with the same SMS message
Office ZED-5462 When merging patients that reference the same SMS message, Zedmed Patient Merger will now only move one copy the message to the merged record. Previously it would
report an error and abort the merge process.

The Last (F4) Button now works in Appointments
While searching for patients on the Appointments Ul, selecting the Last F4 button now selects the last opened patient in the appointment search dialog.
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Tue Hatcher, Danni HEDRICK WARREN HERMAN, GRACE Davis, Phillip
g 9| 0] o 0
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45
g 0 0 0 0
15|
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. 0 0 o 0
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i 15 | 15
30 ]
| Search for Appointments -
as| a5,
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1 5| From  [17/06/2023 To [17wr204 | F
0 30 Date. Time  Duration Declor Resource Branch Status  Notes
as| - - e | Tue 18/07/2023 9:30:00 A6 10 PO MED  Active b
1 2"" 0 0|
s
30
45)
1 0 0 B | 1
15) <« 3
| o]
Print List Delete Refresh Close
IS‘

e |

The Delete button in Staff Maintenance>Apps Access no longer causes an Access Violation

Office ZED-7111 . ! ° X o . .
The Delete button on the staff permissions maintenance dialog, App Access tab, will now remain disabled until a selection has been made to prevent an error.
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Resoved Error Data too large for variable [ITEM_CODE]. Max len = [8], actual len = [9] when running AMA Fee Load
The Load MBS/AMA Item By Criteria option now works when the Load from AMA file checkbox is selected and an AMA load fee file is used. AMA fees will now be loaded as
long as the corresponding MBS item already exists, a report is displayed at the end of the import listing the items that could not be imported.
Load MBS/AMA ftem ®
I3
(®) Load MES/AMA Item By Criteria ]
"C) Update Existing MBS/AMA ltems
Loading Criteria
Item Number
Category | i
Group -
Sub Group
Loaded Items
Item Number Commence Date
Shart
Deseription
Full
Description
Office ZED-7982
HNumber of ltems Loaded : ] €ontinue Without Short Description
Load Item I B rom AMA fi el Clase Cancel
Office ZED-7983 Resolved Error - Param [NEWSTARTDATE] type changed from [ftSQLTimeStamp] to [ftDateTime] running AMA Update Fees
The Update Existing MBS/AMA Items with the Load from AMA file option selected will now run without error and enable the update AMA items.
Office ZED-8233 Statistics report - Referral Doctor criteria now correctly lists all address book entries (not just referral doctors)
Referral Doctor criteria in the Statistics Report will now only list Referral Doctor contacts who are set as Available.
Office ZED-8247 Resolved Error "Zedmed Office was unable to load the OLE object file" when you Select or Preview an archived letter
Fixed the issue with an error being displayed when selecting or previewing patient letters that have been archived.
Clinical ZED-8248 ResoveAd Errolr Type ID Mismatch' when |n?port|nglCDA!etters ) N ) ) ) )
When importing HL7 messages that contain XML files with a namespace prefix, Zedmed Clinical will report a more accurate error instead of returning "Type ID mismatch".
Office ZED-8362 Rlesolved an Intramail error in Sent Iltemls ) ) o ) ) ) )
Fixed an error that occurred when viewing sent items in office intramail when the To: or CC: fields contain a combined total of more than 1000 characters.
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Office

ZED-8367

A double booking Patient's name will no longer change when editing the appointment.
Modifying an appointment by selecting it from the appointment selector (appointment 'Details' context menu option), no longer displays a different patient in the appointment
selector at the end of the process.
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